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Introduction to Adobe Photoshop 4.0Introduction to Adobe Photoshop 4.0Introduction to Adobe Photoshop 4.0Introduction to Adobe Photoshop 4.0Introduction to Adobe Photoshop 4.0

This is part I of two workshops designed to introduce you to Adobe Photoshop, a powerful

graphics creation and manipulation tool. You don't need to be an artistic genius or have previ-

ous experience with Photoshop.

Photoshop 4.0 for Macintosh and Photoshop 4.0 for Windows are almost identical pro-

grams. Keyboard commands are the same except that Mac uses the command (Apple) key

whereas Windows uses the Control key, and Windows calls the Option key Alt.

Copyright RestrictionsCopyright RestrictionsCopyright RestrictionsCopyright RestrictionsCopyright Restrictions
Be aware of copyrights! In general, copyrighted material may be used if:

✰ It is being used in an academic class, and nowhere else;

✰ Only parts of a work, and not the whole work, are used (i.e., only one picture from a book);

✰ The source is always cited, even if the work is only used in a presentation;

✰ The item is used spontaneously (as in a class assignment) and not continuously (as in

courseware: request permission for this).

Remember that simply modifying a work does not protect you from infringing on copyright!

Photoshop BasicsPhotoshop BasicsPhotoshop BasicsPhotoshop BasicsPhotoshop Basics
PalettesPalettesPalettesPalettesPalettes

Navigator:  This palette presents a thumbnail view of the

image and a highlighted box that indicated the size of the

image window. Across the bottom of the palette are the

image magnification and the zoom buttons and slider.

Info:  This palette gives you information about the coordinates

of the cursor and color information for the pixel directly

under the pointer.

Options: The Options palette changes names depending on

which tool is selected. It allows you to choose the attributes,

appearance, or behavior of most tools.

Color/Swatches:  These are color selection palettes used to

set colors that will be used by your tools. Colors that you

sample (click) will change the foreground or background

(Option (Alt) - click) color on the toolbox. You can set

special color palettes or add your own custom colors to the

Swatches palette.

Brushes:  This palette contains the currently defined brushes

and works with all eight painting tools, allowing you to

select the shape and size of the tool.

Actions:  This palette makes it easy to reproduce frequently

used multistep processes and techniques. You use the

palette both to execute actions and to create or edit them.

Layers:  The Layers Palette allows you to create new layers,

delete layers, move layers within a file, duplicate layers, view

a single or selected layer(s), and set options for each layer

in an image.

Channels:  Channels are the color information of an image,

similar to layers. They are also used to save selections

(alpha channels).

Paths:  The Paths palette is for drawing vector paths just like
Brushes Palette

Color/Swatches/Brushes Palettes

Options Palette

Navigator Palette

Info Palette
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in Illustrator. A pen path is a Bezier curve path created

with the pen tool.

Contents of the ToolboxContents of the ToolboxContents of the ToolboxContents of the ToolboxContents of the Toolbox
Marquee: Rectangular, elliptical, or single column or row

selection tool; includes Crop Tool

Move: Moves a selection, layer, or guide

Lasso: Freeform or freeform polygon selection tool

Magic Wand: Makes selections by contiguous color range

Airbrush: Paints a soft-edged (spray-painted) stroke

Paintbrush: Paints a soft-edged stroke

Eraser: Reverts pixels to the background color or a saved

image, or removes pixels on a layer

Pencil: Paints with hard-edged stroke

Rubber Stamp: Clones (duplicates) an area: picks up an area

of color/pattern and repeats it elsewhere

Smudge Tool: Smudges an image like a finger dragging

through chalk, pastel or wet paint

Sharpen/Blur: Sharpens or blurs a part of an image

Dodge/Burn/Sponge: Lightens, darkens or increases/

decreases color saturation

Pen: Used with the Paths palette to create vector paths

Type: Creates text; select font, size, alignment, style; includes

Type Mask tool for text-shaped selection borders

Paint Bucket: Fills single color area with foreground color

Gradient Tool: Fills selection with a blended color

Line Tool: Draw straight lines of varying width with optional

arrowheads

Eyedropper: Samples a color from your image

Grabber Hand: Moves viewpoint of image in window, without

changing the image itself

Zoom: Magnify or zoom out from an image; 1/16 to 16 times

normal size

Foreground/Background color: Buttons that allow you to

change, swap, or revert to default color settings

Standard/Quick Mask Mode: Buttons that turn the quick

mask on and off

Screen Mode Buttons: Allow swapping among normal display,

full-screen image with menu bar, or full-screen image

without menu bar.

Using Selection ToolsUsing Selection ToolsUsing Selection ToolsUsing Selection ToolsUsing Selection Tools
✰ The Marquee selects oval, round, square, or rectangular

areas. Option (Alt)-clicking on the tool toggles between the

rectangle and the ellipse. Holding the Shift key while

selecting constrains you to perfect squares or circles. The

Option (Alt) key draws the rectangle or ellipse around a

central point. If you select an area that includes

transparency with this tool, the selection boundary will

Photoshop’s
Toolbox. Tools are
listed left to right,

top to bottom.

Actions Palette
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shrink to include only areas of active pixels.

✰ The Lasso tool lets you draw a selection boundary.

For complex, detailed selections, hold down the

Option (Alt) key while clicking from point to point on

the outline of your selection. This method draws

straight lines and allows for much greater control over

what is selected. When you release the mouse button,

the selection will close with a straight line from the

ending point to the starting point.

✰ The tolerance of the Magic Wand can be changed so

that more or fewer adjacent color areas are selected.

The lower the tolerance, the fewer the color areas

selected. To fill out a selection use Select… Grow.Select… Grow.Select… Grow.Select… Grow.Select… Grow. To

select everything noncontiguous in the color tolerance,

use Select… Similar.Select… Similar.Select… Similar.Select… Similar.Select… Similar.

✰ To add to a selection with any selection tool, hold

down the Shift key while making additional selections.

✰ To subtract from a selection with any selection tool,

hold down the Command (Control) key while selecting

what you wish to remove.

✰ Change a selection to the foreground color with Edit…Edit…Edit…Edit…Edit…

FillFillFillFillFill or by pressing Option-Delete. Press Delete to fill

with the background color.

Using the Type ToolUsing the Type ToolUsing the Type ToolUsing the Type ToolUsing the Type Tool
✰ To use the type tool, first select the color that you

wish your letters to be. Then click on the type tool

and click in your document. If you do not click exactly

where you would like the type to appear, don’t worry.

You can change the location later.

✰ The Type Dialog Box will appear. Type the point size

you would like in the appropriate box. Click any style

options you would like, such as bold, italics, or anti-

aliased (smooth edges). Select the alignment: right,

centered, left, or the various top-to-bottom choices.

Choose your font from the pop-up list. Then type your

text in the box at the bottom exactly as you want it

to appear. If you want some text to be on a second

line, you must press the Return key. The type will

appear in the box in the font, style and size you have

chosen. Click OK when you are done.

✰ Your type will appear in your document in the active

color. It will also be selected. To move it, move the

mouse over the text until the pointer becomes an

arrow. Click and drag the text to the desired position

and release the mouse button. Click anywhere else in

the document, or type Command-D to drop the

selection and see your text.

The Type Tool Dialog Box



Alisandra BrewerAlisandra BrewerAlisandra BrewerAlisandra BrewerAlisandra BrewerPage 4Page 4Page 4Page 4Page 4

www.sonoma.edu/it/people/alisandra

✰ Note:Note:Note:Note:Note: For complex text images, using Adobe Illustrator or

Macromedia FreeHand is recommended. Images created in

Illustrator may be easily imported into Photoshop. Use of

Illustrator or FreeHand are not covered in this workshop.

RulersRulersRulersRulersRulers
✰ To show rulers on the top and left sides of a document

window, choose Show Rulers from the View menu. When

the rulers appear, the units will be the same as those you

last selected in the Info palette. Reset the units in the Info

palette or through the Units submenu of the Preferences

command off the File menu. The cross-hair in the upper

left hand corner of the rulers is used to set the Zero Point.

Using the Layers PaletteUsing the Layers PaletteUsing the Layers PaletteUsing the Layers PaletteUsing the Layers Palette
Layers are like clear sheets of acetate laid over your

background layer. They allow you to add to and change

your image without losing the paint underneath.

Create a new layer. Click on the New Layer icon at the

bottom left of the palette.

Delete a layer. Drag the layer to the trash can at the bottom

right of the palette.

Move a layer within a file. Drag the layer name or thumbnail

to the desired location and drop it.

Duplicate a layer. Drag the thumbnail of the layer you wish to

copy to the New Layer icon.

Hide a layer. Click on the eye icon in that layer bar.

View a single layer. Option (Alt)-click on the eye icon of the

layer you’d like to isolate. Note that this does not

automatically make the layer active. Option-clicking again

will make all layers visible again.

Opacity refers to how much of the image that is beneath a

given layer is visible through that layer. 100% opacity

means the layer is totally opaque (solid) wherever there are

colored pixels.

Preserve transparency is layer-specific. It masks out any

transparent pixels on a layer, so only pixels that already

have paint can be altered. This is similar to how a

selection does not allow you to paint outside the marching

ants, without the bother of making a selection.

TransparencyTransparencyTransparencyTransparencyTransparency
✰ The gray and white checkerboard you sometimes see in

Photoshop represents transparency. It is like painting on a

clear sheet of acetate. When you draw on the transparency,

only the pixels that you have altered contain color

information (these are the active pixels). If you select part

of an image on a layer, the background will not be part of

the selection.

Photoshop’s representation of
Transparency

with Rulers and Zero Point showing

Layers Palette
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The New File Dialog Box

Creating a New ImageCreating a New ImageCreating a New ImageCreating a New ImageCreating a New Image
Notice that when Photoshop is launched, it does not

automatically open a blank file for you. You will see only

the palettes that you left open the last time you quit

Photoshop. All of the lab machines at SSU should open

with the default palettes and settings. The palettes can

be reset to their original locations through the File…

General Preferences dialog box.

Open a new document.Open a new document.Open a new document.Open a new document.Open a new document. Choose the size you desire. You

can easily make it smaller later, so overestimate, if

necessary. We could also add to the size later. You can

choose a name for your document now, but remember,

this does not save a copy on your disk! You must use

the File… SaveFile… SaveFile… SaveFile… SaveFile… Save or File… Save As…File… Save As…File… Save As…File… Save As…File… Save As… command to do this.

Choose 72 dpi and leave white as the background color

for our practice files. Your saved file size will increase

exponentially as you increase the dpi. Therefore the

saved file size on a 150 dpi file is four times that of a

72 dpi file, not just twice as large.

UndoUndoUndoUndoUndo
✰ Photoshop only allows one level of Undo — so be

careful! Always Save before attempting anything tricky.

And remember, just about everything is Undo-able in

Photoshop, including things like deselecting. So if you

move part of your image and then deselect it, it’s too

late to Undo the move!

PathsPathsPathsPathsPaths
Paths can be frustrating to learn, but powerful to use.

The Pen Tool is the only tool that does not reside in the

toolbox. It is a Bezier curve drawing device. You can

create lines and shapes that can be fine-tuned, saved as

paths, filled or stroked, and converted to selections.

Anchor points are joined by segments, which link to

make a subpath. Subpaths combine to form paths.

Drawing a straight line: Click in the image window with the

pen tool to create an anchor point. Click again

elsewhere to create a second point. A line segment will

be drawn between the two.

Drawing a curved line: Create an anchor point. Click and

hold the mouse button down elsewhere. A slightly

curved line will form between the two.

The arrow tool (in the Pen tool pull-out box) is used to

move anchor points. The corner tool can be used to

change the anchor points from curves to corners to

straight lines.

The Paths palette, used with the Pen tool

The General Preferences Dialog Box
Click on the bottom button to return all

palettes to their default positions
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Color ModesColor ModesColor ModesColor ModesColor Modes
(in the Image… ModeImage… ModeImage… ModeImage… ModeImage… Mode sub-menu)

Greyscale: mode This is not black & white! A greyscale

image has 256 shades of grey, from solid black (0) to

pure white (255), used to make up a picture.

RGB mode: Red, Green, & Blue are additive colors of light

displayed on your monitor. The more saturated (dense) the

colors become, the closer the value gets to white.

CMYK mode: Cyan, Magenta, Yellow, & blacK are subtractive

pigment inks used in the four-color printing process;

therefore they are called process colors. Translating an

image from the computer screen (RGB) to the printed

page requires color separation, so RGB must be converted

into CMYK files before color separations can be created for

truly accurate high-end printing. Low-end printers

(StyleWriters, DeskWriters or Deskjets, or Epson Stylus) will

do an adequate interpretation of RGB for home printing.

Bitmapped mode: In contrast to greyscale mode, bitmapped

mode offers only black and white pixels — no colors and

no shades of gray. These images cannot be scaled,

distorted or treated with filters. To convert a file to

bitmapped mode, it must first be converted to grayscale.

Indexed color mode: Indexed color is a custom palette of

colors that is particular to an image. GIF files must be

converted to an indexed color mode before saving to

reduce the saved file size.

✰ A palette can either refer to a set of tools in Photoshop, or

to a set of colors that makes up an image. When you save

a GIF image for the web, you need to use a palette of no

more than 256 colors. (Note that if you save a JPEG

image, you may use a palette of millions of colors.)

✰ The palette that you select will depend on your image and

on the platform (Mac, PC, etc.) on which you expect to

display your image. If you do not know which platform will

be used, as is often the case with the web, you may wish

to use a more limited palette of 216 colors.

✰ The reason to use this more limited palette is that

Windows, a common PC operating system, limits the

number of “free” colors in a browser window to 216 when

the monitor can only display 256 colors. 40 colors are

reserved for use by the Windows system itself, to draw the

screen. If an image in a browser window takes more than

216 colors, Windows will substitute “close” colors for the

extra ones. The result is that your image will not look as

you expected if someone views it on a Windows machine.

Note that if the monitor allows more than 256 colors, this

problem does not occur.
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Using the Painting ModesUsing the Painting ModesUsing the Painting ModesUsing the Painting ModesUsing the Painting Modes
Photoshop 4.0 offers different painting modes, found on the

pop-up menu on the various painting tools’ Options palette

and on the layers palette. These modes affect the way the

overlying brush stroke changes the underlying pixels.

Normal mode: (1) The blend paint covers the underlying

pixels. This is the most common mode used.

Darken mode: (2) Only pixels lighter than the blend color are

changed.

Lighten mode: (3) Only pixels darker than the blend color are

changed.

Hue mode: (4) The hue of the underlying pixels changes to

that of the blend color, but the saturation and luminosity

(brightness) are maintained.

Saturation mode: (5) The saturation of the underlying pixels

changes to that of the blend color, but the hue and

luminosity are maintained.

Color mode: (6) The underlying base pixels change to the

blend color, but the luminosity is retained. This mode is

good for colorizing grayscale without changing the gray

levels.

Luminosity mode: (7) This is the opposite of the color mode.

The luminosity of the underlying pixels changes to that of

the blend color, but the color values are not affected.

Multiply mode: (8) Uses a mathematical formula to darken

the image.

Screen mode: (9) Lightens the base pixels while giving them

a tint of the blend color. The opposite (inverse) of the

multiply mode.

Overlay mode: Either multiplies or screens depending on the

base color. This has the effect of changing the base color

to the blend color while maintaining highlights and

shadows.

Dissolve mode: (10) The blend color replaces the base color

at random, based on the density (opacity or brush

hardness) of the applied paint. The example line is painted

at 50% opacity.

Color dodge and Color burn modes: Using these modes is

like dodging or burning with color.

Soft light and Hard light modes: Soft light is like a diffused

light source while Hard light is focused. Colors more than

50% gray darken the base color while colors under 50%

gray lighten it.

Behind mode: Paints only on the transparent part of a layer.

The effect is of painting under the base color.

Clear mode: Makes pixels in a layer transparent. Works with

the line tool, paintbucket tool, Fill or Stroke.
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The Channels Palette

ChannelsChannelsChannelsChannelsChannels
Channels are similar to layers, in that they contain partial,

layered information about an image. An RGB image has

three channels; a CMYK has four; a greyscale has one

black channel. Photoshop files can have a total of 24

channels, most of which will be added mask (alpha)

channels. Bitmapped images cannot have alpha channels.

Channels are also used to store and edit a selection. Select…Select…Select…Select…Select…

Save SelectionSave SelectionSave SelectionSave SelectionSave Selection or clicking on the Save Selection button

on the bottom of the Channels palette will create a new

channel below the color channels in the Channels palette.

These are alpha channels and can be exported in PICT

and TIFF formats for use in other applications.

Channels contain only greyscale (256 shades) information

about your image.

The Actions PaletteThe Actions PaletteThe Actions PaletteThe Actions PaletteThe Actions Palette
If you’ve worked in programs that utilize macros

(WordPerfect, MS Word, MS Excel, etc.), you are familiar

with the concept of scripting complex actions into a

command you can execute easily with just a mouse click

or single keyboard command.

Photoshop’s Actions palette allows you to do just that. The

default settings already have several commands scripted

for you. Actions are made up of steps of commands, and

each step may have substeps or settings. In Button Mode

(in the Actions palette pop-up menu) the steps are hidden,

but in List Mode the steps can be expanded and edited.

The first column of the Action list displays a check mark to

show that Actions or steps are include and usable.

Excluding steps is a convenient way to temporarily alter

Actions without rewriting them.

The second column toggles break points on or off for an

entire Action or single step. Break point within an action

pause action execution to wait for user intervention. This

may be to fill in options in a dialog box, make a

selection, or supply some other variable. Photoshop will

not let you turn on a break point for a step with no

options. And if a break point is not turned on, the Action

will execute without pausing, using the option values

recorded.

The simplest way to create an Action is to actually perform

the steps while recording in the Actions palette.

Photoshop will alter your image as you do this, so you

might want to work on a copy of your file.

You can assign Function keys (F1 — F15 across the top of

your keyboard) to steps for one-keystroke implementation

of your favorite commands!

The Actions Palette in List Mode
with two actions expanded
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Saving Your Images for the WebSaving Your Images for the WebSaving Your Images for the WebSaving Your Images for the WebSaving Your Images for the Web

1.1.1.1.1. Flatten your image.Flatten your image.Flatten your image.Flatten your image.Flatten your image. We want to mash all the layers together,

except the white background. First, make sure that all the

layers are showing (there is an eye in the left-most column

in the Layers Palette). Then hide the background layer by

clicking on the eye in that layer to make it disappear. You’ll

see the transparency appear, and the white background will

vanish. Next, choose Merge Layers from the Layers pop-up

menu. Make sure that the background isn’t the active layer

before you merge layers, or that option will be grayed out.

2.2.2.2.2. Select one item. Select one item. Select one item. Select one item. Select one item. Choose an icon, a heading, or a bar and

select it with the marquee. It doesn’t matter if you use the

lasso or the marquee tool, as long as you completely select

the item you want, and don’t select any part of any other

item.

3.3.3.3.3. Copy the item and paste it into a new document. Copy the item and paste it into a new document. Copy the item and paste it into a new document. Copy the item and paste it into a new document. Copy the item and paste it into a new document. Choose

Copy from the Edit menu. Next, select New from the File

menu. Photoshop will suggest a size that exactly fits the

image you just copied, so don’t change the dimensions.

Click OK in the New Image dialog box. Paste your image

into the empty space, and then drop it by pressing

Command (Ctrl) - D. Don’t try to drop the image by clicking

inside the window, since you might move it and cut part of it

off.

4.4.4.4.4. Change the new image to Indexed Color.Change the new image to Indexed Color.Change the new image to Indexed Color.Change the new image to Indexed Color.Change the new image to Indexed Color. From the Image…Image…Image…Image…Image…

ModeModeModeModeMode submenu, choose Indexed Color. In the dialog box

that appears, select Web palette and None for dither. Notice

that the Web-safe palette only has 216 colors. This is to

make your GIFs safe for Windows-based browsers. If your

intended audience has Macs, or Windows machines with

more than 256-color display, you can choose the system

palette. Click OK. If you picked your colors well at the

beginning, your image should look pretty much the same.

5.5.5.5.5. Save your image in GIF format.Save your image in GIF format.Save your image in GIF format.Save your image in GIF format.Save your image in GIF format. Photoshop only saves

rectangles, and automatically changes any transparency to

white in all formats except Photoshop. If you do not need

transparency, go ahead and choose Save As... and select

Compuserve GIF in the Format pop-up menu. If you want to

preserve transparency, you must use File… Export… GIF89aFile… Export… GIF89aFile… Export… GIF89aFile… Export… GIF89aFile… Export… GIF89a

Export….Export….Export….Export….Export…. You will get a dialog box that will allow you to

choose colors (e.g., white) that you wish to be omitted in the

saved image. Name your image something.GIF and click

Save. Now you can display it on the web!

6.6.6.6.6. Repeat steps 1-5 Repeat steps 1-5 Repeat steps 1-5 Repeat steps 1-5 Repeat steps 1-5 for each of the images you wish to save

for the web.

Sampling colors for transparency in the
GIF89a Export command

Saving the File as GIF

Changing to Indexed Color
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~ NOTES ~~ NOTES ~~ NOTES ~~ NOTES ~~ NOTES ~


